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Editorial Guidance for AMAP Reports 
 
 
All AMAP assessment reports (and most technical reports) are subject to editing by a professional 
technical/linguistic editor. As a result, drafting groups/authors can focus on producing high quality science 
and leave editorial work to others. The following information provides general guidance to aid the editing 
drafting/process and hopefully avoid pitfalls identified through past experiences.  
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Documents 
For general manuscript drafts, prepare texts and tables in Microsoft-Word (2000 or higher; with file 
extension .docx, or .doc). If this is not possible, use .rtf or .txt files for exchanging texts.  

For tables, it may be appropriate to prepare/provide material in spreadsheets (see notes on tables below). 

For graphic materials, see notes on graphics files below. 

Document Exchange Site 
The AMAP Secretariat will set up a work area on the password protected part of the AMAP website 
(www.amap.no > Work area) that is available to assessment groups for document exchange and general 
internal communication.  

Each expert/assessment group has its own area, with its own access code(s). Usernames and passwords 
providing access rights will be issued to assessment group members, authors groups, reviewers, etc. by the 
AMAP Secretariat. Assessment leads are responsible for administrating who has access to given folders on 
their work area. The intention is to keep the site as secure as possible, therefore, all those with access to 
the work areas should be aware of the need to keep the access codes confidential, and avoid copying on e-
mails containing access information, etc. 

Documents can be uploaded to a password protected area by individuals who have the necessary 
permissions, or by the AMAP Secretariat. The AMAP Secretariat can assist in setting up the work areas to 
meet the group needs (contact Simon Wilson, s.wilson@inter.nl.net). 

File naming/Document tracking 
The drafting and editing process will require several iterations of material. It’s important to keep track of 
document versions so that draft versions don’t get mixed-up and so that the correct files can be found and 
identified. Therefore, assessment leads should adopt a system that everyone agrees on for file-
naming/document tracking. 

Make sure that file names include the Document title (e.g. chapter/section), draft number plus date of most 
recent revisions (used for versioning), and optionally other attributes you may choose to use to identify e.g. 
author, version, person adding comments, etc. Add this information also to a page header/footer 

Example: GRIS_Chapter5-Draft2-15dec2013-Steffen 

Page Layout 
It is often useful to set line spacing to 1.5 to make drafts containing dense texts easy to read/annotate. 

[MS-WORD 2010: Home > Paragraph >Line spacing > 1.5] 

Add page numbers (useful when a stack of paper is dropped) but be aware that text flow will be different if 
documents are printed on different paper sizes with different margin settings, etc.  

[MS-WORD 2010: Insert > Page Number] 

Therefore, for any documents that are circulated for comment/review, it is useful to include continuous 
line numbering. 

[MS-WORD 2010: Page Layout > Line numbers > Continuous]  

http://www.amap.no/
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For any draft documents that are circulated for external comment/review1, a watermark and/or header 
text saying DRAFT-DO NOT CITE, CIRCULATE  OR COPY should be included.  

[MS-WORD 2010: Page Layout > Watermark  > Custom Watermark > Text Watermark (modify as 
appropriate)]  

[It is also possible to add watermarks to adobe PDF files if you have Adobe Acrobat software] 

Words per page 

As a rule of thumb, a typical AMAP scientific assessment report contains about 750-1000 words per printed 
page (full text pages). The amount of graphical content is variable, but an approximate estimate would be 
that a printed AMAP scientific report is typically about 20% tables/graphics.  

An A4 page of draft text in Time New Roman 11/12 point font and 1.5 line spacing will have 450-500 words 
per page. So a reasonable estimate is a printed scientific assessment report  corresponds to about 1.3-1.5 
pages of draft manuscript (text, 1.5 line spaced). 

General formatting of texts, tables and graphics 

Texts 

Spelling and punctuation follow American English. The few ‘AMAP exceptions’ will be dealt with by 
the editor. For example, ‘autumn’ will replace ‘fall’ to avoid confusion with decline/reduce etc. 

For basic drafting use a common font (e.g. Times New Roman or Calabri). If characters are not 
available in the standard font try to find them in the ‘Symbol’ font set.  

Use basic text formatting features (bold, italics, different font sizes) if necessary to add structure 
to documents, or to emphasis headings or special terms, etc. but in general be aware that all of 
this formatting will be stripped out during editing and replaced with standard formatting 
conventions applied by AMAP.  

Do not use advanced layout features (e.g., columns, heading styles, text boxes etc.). Anything of this nature 
will be stripped out before editing. 

If you want to make the editor aware of specific needs for formatting add notes comment boxes 
or (if clearly visible, e.g. in CAPITALS) in the running text. For example, if you want to include a box 
text, indicate this with instructions, such as START OF TEXT BOX, END OF TEXT BOX (or place the box text in 
a single celled table). 

A table of contents is not required. This will be drawn up by the designer. Having said this, however, if you 
want to include a table of contents during drafting as an aid to organizing/identifying material feel free to 
do so. 

Do not spend time positioning tables and/or images in the Word files. The designer will position 
the tables/graphics during layout.    

 

 
                                                      
1 NB. The AMAP Secretariat will generally coordinate/assist with circulation of documents for external review, 
including posting of documents on (password restricted) review web-sites, checking/adding watermarks if necessary, 
etc. Depending on whether returned comments are expected in the form of documents with revision-markup or 
comments referenced to line numbers, external review documents are often converted to PDF files before circulation. 
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Section numbering 

Try to limit section numbering to not more than four levels (Chapter 5 and then 5.1, 5.1.1, 5.1.1.1, 
and 5.1.1.1.1). Try to avoid using automatic numbering if possible. If more headings levels are 
needed they should be prefixed by H5, H6 etc.  

It is not necessary to style headings – numbering is sufficient. Headings should contain lower case 
letters except for the first letter of the first word and proper nouns, etc. 

Equations 

Construct equations using the Equation function in Word (if possible). This looks neater in the published 
report than equations constructed by hand. For complicated equations, if you can also supply a picture 
(image file) that can be used during layout to make sure the equation is correctly reproduced. 

Some specific formatting instructions: 

• Use SI units (www.bipm.org/en/si/base_units/); but use “L” for litre rather than “l” 

• Use ‘/’ for ‘per’ rather than negative superscripts 

• Present radionuclides as 137Cs not Cs-137 or 137Cs 

• Give the common name and Latin name on the first occurrence of each biological species, thereafter the 
common name is enough 

• Do not italicize Latin expressions (vice versa etc.) and abbreviations (e.g., i.e., et al.) 

• A prefix-word construction (e.g., micro g/L) is preferred to Greek symbols (as in µg/L). This will be 
corrected by the editor before layout.  

• Use the Times World Atlas spelling conventions for place names, but for places with different names 
(e.g., in a local language) include both alternatives. 

Helping the editor! 

Character conversion issues still occur; these are generally spotted but consistency in use of special 
characters and selecting the fonts used for these helps a lot. For example, Times New Roman contains a 
degree symbol. This should be used in preference to anything else (e.g. the masculine ordinator, a 
superscript zero, etc.). Although the alternative symbols may look identical on a screen they can look very 
different in layout and will need replacing. 

There is no need to add a double space after a period / full stop. This is a hangover from the days of paper 
and typewriters – modern software compensates by inserting an extra-large space after a period / full stop.  

Do not use joining spaces. These will all need to be deleted by the editor to prevent problems during 
layout. 

For reference lists based on a file output from an EndNotes database held by the AMAP Secretariat, it 
would be extremely helpful for updates to existing references and new references to be highlighted in 
some way. This will help to identify new material to be added to the EndNotes database (although the 
editor will still do a visual comparison to pick up any new material that is not highlighted).  

Tables 
Construct tables using the ‘Table’ feature in Word if possible. This will ensure the data are contained in 
cells. Tables constructed using tabs, carriage returns and/or spaces to align the data can ‘fall apart’ when 
the files are imported and manipulated by the designer. Avoid if possible or limit the formatting of tables 
(merging of cells etc.) – this will all be done by the designer.  

http://www.bipm.org/en/si/base_units/
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Spreadsheets are convenient for maintaining numerical data, performing calculations, etc. – especially large 
tables – and data stored in this manner can generally be copied/pasted or imported into WORD tables 
without too much difficulty. If data are maintained in spreadsheets, by all means supply these as well as 
WORD versions. 

Include comments on material in the tables in notes below the table. Link these table notes to the table 
contents as follows: by superscript letters if the table is mainly number-based and superscript numbers if 
the table is mainly text-based. 

Ideally, tables should fit within an A4 ‘portrait’ page. Avoid A4 ‘landscape’ page tables unless absolutely 
necessary. 

Each table requires a caption that includes the source of the data.  

Table numbering: 

Each table requires a unique identifier that will remain unchanged through the drafting/editing process. 
This will prevent confusion (e.g., in table referencing) if tables are moved, inserted, deleted or merged. 
During drafting, do not worry about making numbering consecutive; making sure the table references are 
unique is more important. It may be useful to exclude serial numbers altogether (e.g. TableTom, TableDick, 
TableHarry) to avoid the temptation to ‘correct’ the numbering if tables are moved, etc. Table numbering 
will be checked/corrected by the technical/linguistic editor.  

Submitting tables 

Tables may be submitted within the Word file as part of the running text or in a separate Word file. Large or 
complex tables should also be submitted in their original form (e.g., as an Excel file).  

Tables prepared in spreadsheet software (e.g., Excel) must be ‘inserted’ into Word documents and the 
associated Excel (.xls or .xlsx)  file also supplied. Spreadsheets should not be ‘linked’ to the Word files. 

Tables are not to be introduced into drafts as an image – these cannot be manipulated by the editor or 
designer and would need to be copy typed prior to layout (which may introduce errors).  

Graphics 
All graphics - at least those included in AMAP scientific and summary assessment reports - are normally 
reproduced in the AMAP ‘house-style’ (sizing, label styles and fonts, colour standardization, etc.).  These 
requirements may be relaxed for some more technical reports. AMAP graphics collections are also made 
available (via the AMAP website) as image files in various formats for wider use (with appropriate 
documentation of metadata including sources, etc.).  

AMAP has access to graphical designers and GIS (geographical information system) specialists who conduct 
work associated with mapping and graphics products for AMAP reports, and who can assist in generating 
high quality products. If you have ideas for new original graphics, by all means communicate these and we 
will help produce what you want – this often works better than using existing graphical material that is sub-
optimal. 

Each graphic requires a caption that includes the source of the information and/or relevant source citation. 
If captions are developed/modified, please provide enough information so that all elements on the graphic 
are clearly defined/explained. 

Photographic materials should include the name of the photographer (and affiliation if relevant), and 
information describing the subject, location, etc.  

In order to reproduce graphics correctly, it is desirable to obtain either vector graphics files and/or datasets 
represented on maps, graphs, etc. Failing this, we can work (to some extent) with bitmap (i.e. pixelated / 
raster) graphics, but this is highly dependent on the quality of the original materials supplied. 



  
 

6 

Figure numbering: 

Each figure/graphic requires a unique identifier that will remain unchanged through the drafting/editing 
process. This will prevent confusion (e.g., in figure referencing) if graphics are moved, inserted, deleted or 
merged. During drafting, do not worry about making numbering consecutive; making sure the figure 
references are unique is more important. It may be useful to exclude serial numbers altogether (e.g. 
FigureAA, FigureBB, FigureAAX) to avoid the temptation to ‘correct’ the numbering if graphics are moved, 
etc. Table numbering will be checked/corrected by the technical/linguistic editor.  

Submitting graphics 

Submit each graphic in a separate file in a commonly used graphic format. 

Graphics formats fall into two general categories, vector graphics and bitmap/raster graphics formats. The 
former can be easily manipulated/modified; the latter cannot. In addition, graphical products are 
frequently representations of datasets (including geospatial datasets used in GIS and mapping 
applications). 

If at all possible, please supply editable vector graphic files, for example 

• .ai – Adobe Illustrator file 

• .eps - encapsulated postscript file 

• .pdf – editable PDF file. 

If possible, please also supply the data that are represented on graphics (e.g. in Excel files, other  dataset 
formats, including shapefiles (.shp), layer files (.lyr) and exchange files (e.g. .e00) used for exchange of GIS 
data. 

If the previous options are not possible, supply raster/bitmap graphics (e.g., .pdf, .gif, .jpg, .jpeg, .nef, .psd, 
.raw or .tiff files) in as high resolution as possible. Note: scanning or using image processing software to 
make a ‘high resolution’ file from a low resolution original (upscaling) does not improve the resolution and 
may have undesirable effects (e.g. interpolating colours for pixels in the boundary between two different 
coloured areas). 

Again (if possible) also submit the underlying data (e.g., as an Excel file) as this will allow the designer to 
rework the graphic.  

Various solutions exist for transferring large files – these include dropboxes, ftp, uploading to the AMAP 
website, large file transfer services, skype file transfer, etc.  The AMAP Secretariat can advise on this.  

Photographs 

Photos must be supplied in high resolution. As a rule of thumb, photos should be at 300 dpi (dots per inch) 
for the size of eventual reproduction in the published report. So a photo occupying a typical column width 
of 11 cm and 5 cm high would need to have a resolution of 1300 v 600 pixels; a full A4 cover image (21 x 
29.7 cm) would need to be 2480 x 3500 pixels. Depending on the subject, it may be possible to employ 
lower resolutions (down to ca. 240 dpi) but remember also that photos are often cropped to focus on a 
particular part of the image so this also needs to be taken into account. As file sizes for photos can be large, 
see comments above relating to large file transfer options. 

As a general rule – avoid searching / sourcing photos from the web – they are generally placed on the web 
in low resolution (often 72 or 96 dpi and small sizes). While and copying/pasting these into e.g. PowerPoint 
presentations works, reproducing them in printed documents does not. If photos (or other graphics) are 
sourced from the web, you will need to consider rights issues (see Copyright below); if you do search for 
materials on the web, options exist in the search engines for searching only images with ‘large’ size; this can 
produce search results that are more likely to have adequate resolution. 
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As with graphics, a low resolution photo generally cannot be made into a higher resolution photo by image 
processing without loss of definition. Available graphical expertise can sometimes enhance or fix photos 
but do not rely on this.  

Subject matter should be relevant (e.g. Arctic images and not Antarctic images for the Arctic reports).  
Please supply photos together with clear captions describing the subject/location and name of 
photographer (with contact details if possible).  

Commercial photos are only generally purchased in special cases (e.g. for cover images). If commercial 
photos are proposed for inclusion, contact information for the photographer or source is required. 

Copyright 

Authors must check whether the material they are submitting is covered by copyright. This is particularly 
the case for graphics. If the material is covered by copyright, then they must get permission for the material 
to be used. The AMAP Secretariat can supply authors with a pro forma document for sending to copyright 
holders. 

Reviewer Instructions 
AMAP assessment reports are normally subject to two types of review, ‘national’ review and ‘peer’ review.  

National Review 

National reviews are performed on the first reasonably complete draft of an assessment report. The 
compiled draft is line numbered and watermarked and then circulated to national contact points in the 
Arctic Countries (AMAP Heads of Delegation) and contact points for Permanent Participants), who are also 
responsible for compiling and returning national comments by the agreed deadline. National reviews are 
conducted to address the following questions: 

• Are there important (national) data that have not been used in the assessment? 

• Have (national) data been interpreted in a valid and correct manner? 

• Are there omissions or gaps in the subjects addressed that need to be filled? 

In the case that relevant (national) data/information is identified that has not been taken into account in 
the assessment so far, it should be made available together with the review comments. 

Comments of an editorial/linguistic nature are not necessary as all assessment reports are subject to a 
thorough technical/linguistic editing following the peer review. Similarly, graphical content is likely still 
under development so that although suggestions for improvements are welcome, as are notes regarding, 
for example, errors in units or labeling, undue effort should not be expended on the general appearance of 
the graphics. 

Peer Review 

After national review comments have been addressed, report drafts are subject to a peer review, 
conducted by independent peer reviewers (i.e. suitably qualified individuals who have no other perceived 
interest in the assessment work, have not been engaged in drafting the assessment and have no other 
possible conflict of interests). Peer reviewers are nominated through an open process and appointed by the 
AMAP WG and/or AMAP Secretariat.  

Normally, attempts are made to identify two peer reviewers per major section (e.g., chapter)  of an 
assessment report, and two-three additional reviewers who will consider the report in its entirety to check 
for overall consistency and completeness (to address possible contradictions, gaps, unclear messages, 
inconsistencies between chapters, etc.).  
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When the peer-review has been completed and review comments handled, the assessment draft is handed 
over to a professional editor who will undertake linguistic and technical editing in association with lead 
authors before the report goes for layout and publication. 

References 

References cited in the text 

References are to be cited using the name-and-date system (i.e., the surname of the author and the year of 
publication). References with two authors are cited as: Reiersen and Wilson, 2011. References with three or 
more authors are cited as: Reiersen et al., 2011.  

References in a string are separated by a semicolon and ordered chronologically. 

Articles accepted for publication are listed as: Reiersen et al., in press. Do not use the expected date of 
publication – publication may be delayed and the date may become incorrect. The editor will search for ‘in 
press’ at the proof stage and can update the material (if this flag is not used then incorrect information may 
be left in the text).  

Personal communications (pers. comm.) are to be avoided. If they must be used, then a date and affiliation 
are to be given with the name. 

References ‘in preparation’ or ‘submitted’ at proof stage will be deleted or converted to a personal 
communication by the editor. 

Reference list 

Each chapter is to have a single reference list at the end. The Chapter Lead is responsible for checking that 
text citations correspond to those in the list at the end of the chapter, and vice versa. Check that references 
in tables and graphics are included – these are often missed.  

References are to be listed at the end of the chapter in alphabetical order according to the surname of the 
first author. For a particular first author the references are ordered as follows. 

• Single-authored papers (Reiersen, 2011) are listed chronologically, starting with the earliest paper. If the 
author has more than one publication in a given year, these are distinguished by an alphabetic sequence 
after the date (Reiersen 2011a, Reiersen, 2011b) (NB remember to update the text citation)  

• Dual-authored papers (Reiersen and Wilson, 2011) are listed alphabetically by the second author.  

• Papers with three or more authors are arranged chronologically, regardless of the number of authors. 

If available, internet addresses should be provided for ‘grey’ literature. 

References are to include all the categories of information (title, page range etc) shown for the various 
reference types in Annex A. Authors do not need to format the references. The editor will enter the 
material into an EndNotes database and output the material in the AMAP house style. 

Endnotes 

The AMAP Secretariat holds a number of EndNotes databases containing references used in previous AMAP 
assessment reports. The AMAP Secretariat will supply a Word file of references to authors on request – this 
should reduce the time taken by authors in drawing up their reference list.  

Once an assessment report has been signed off ready for printing, the editor will prepare/update an 
EndNotes database to be held by the AMAP Secretariat for use in subsequent assessments. 
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Abbreviations and acronyms 
All acronyms are to be given in full the first time they are used. Do not make up new acronyms. The 
Chapter Lead is responsible for compiling and submitting a list of abbreviations and acronyms.  

Data Use Agreement 
All authors taking part in the AMAP assessment process are required to sign the ‘Data Use Agreement’ 
drawn up by the AMAP Secretariat. Assessment Leads are responsible for collating and returning signed 
copies of the Data Use Agreement to the AMAP Secretariat. 
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Annex A: AMAP house style for references 
Journal article 
Abdalati, W. and K. Steffen, 2001. Greenland ice sheet melt extent: 1979-1999. Journal of Geophysical 
Research, 106:33983-33988. 

Journal – Entire issue 
Putiakka, J., J. Rintala, J. Wartiovara and P. Heinonen (Eds), 1991. Proceedings of the Third IAWPRC 
Symposium on Forest/Industry Wastewaters. 5-8 June 1990, Tampere, Finland. Water Science and 
Technology, 24:1-447. 

Corporate author 
AMAP, 2011. Arctic Pollution 2011. Arctic Monitoring and Assessment Programme (AMAP), Oslo, 
Norway. vi + 38pp.  

Book 
Clark, R.B., 1997. Marine Pollution. Clarendon Press. 161pp. 

Edited book 
Stein, R. and R.W. Macdonald (Eds.), 2004. The Organic Carbon Cycle in the Arctic Ocean. Springer, 
336pp. 

Book in a series 
Cushing, D.H., 1996. Towards a Science of Recruitment in Fish Populations. Excellence in Ecology, No. 7. 
175pp. 

Book section 
Wiener, J.G. and D.J. Spry, 1996. Toxicological significance of mercury in freshwater fish. In: Beyer, W.N., 
G.H. Heinz and A.W. Redmon-Norwood (Eds.). Environmental Contaminants in Wildlife:  Interpreting 
Tissue Concentrations, pp. 297-339. CRC Press. 

Conference paper 
Rose, G.A., 2004. On distributional responses of North Atlantic fish to climate change. ICES Symposium on 
Influence of Climate Change on North Atlantic Fish Stocks. 11-14 May 2004, Bergen, Norway. pp. 1360-
1374. 

Conference proceedings 
Schroeder, W., 2002. Arctic Atmospheric Mercury Research Workshop. 26-28 August 2002, Toronto 
Canada. 

Thesis 
Loseto, L.L., 2007. Beaufort Sea beluga whales: an ecological approach to examining diet and dietary 
sources of mercury. PhD. Thesis. Dept of Zoology, University of Manitoba, Winnipeg. 
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